Accessorize Your Design – Dynamo for Civil 3D

Stacey Morykin
Pennoni

Dylan Kahle
Pennoni

**Learning Objectives**

- Learn how to import and manipulate AutoCAD objects and/or Civil 3D data
- Identify repetitive tasks in your daily workflow
- Learn how to produce Dynamo for Civil 3D scripts to automate repetitive tasks
- Discover ways that Dynamo for Civil 3D can elevate efficiency

**Description**

Have you heard of Dynamo, or do you think it’s a program only for Revit users? If you’re not a programmer and wouldn’t know where to start, we welcome you to Dynamo for Civil 3D software! Dynamo is already popular with architects and engineers using Revit software to design buildings, but if you’re an engineer who primarily works in the horizontal infrastructure space, Dynamo may be very new to you. In this class, we’ll focus on the Dynamo add-in for Civil 3D 2020. We’ll explore the import of AutoCAD and Civil 3D objects, the types of geometry you can create, and the functions you can apply. Discover the meaning and application behind the terms “nodes,” “connectors,” “code blocks,” and “lists.” Learn how to easily create a visual script to automate a repetitive task in your daily workflow, and how to apply that script to your design. Finally, join the Dynamo open-source community, where you can contribute to improving Dynamo for Civil 3D!

**Speaker(s)**

Stacey Morykin works with AEC professionals to enhance their workflow through innovative technology. After spending nearly two decades in design, development, implementation, support, and management of computer and non-computer-based technologies, Stacey truly understands the importance of communicating product design intent and constructability. She believes the effective use of technology within all phases and aspects of BIM optimizes project results by increasing value and reducing waste. Stacey has worked with small and large engineering firms within Central and Eastern Pennsylvania, fostered the redevelopment of an Autodesk User Group within Philadelphia, and teaches Engineering Graphics to students at Northampton Community College. Stacey is currently a Certified Professional in the current version of Civil 3D and holds an Associate Degree in Computer Science.
# Table of Contents

- Accessorize Your Design – Dynamo for Civil 3D ........................................................ ................ 2
- Learning Objectives .............................................................................................................. 2
- Description ............................................................................................................................ 2
- Speaker(s) ............................................................................................................................. 2
- Introduction to Dynamo ......................................................................................................... 5
  - Why would I use this? ........................................................................................................... 5
  - How do I install it? .............................................................................................................. 5
    - Install through Autodesk Account .................................................................................. 6
    - Install through Autodesk Desktop Application ............................................................. 7
  - Where do I find it once installed? ....................................................................................... 8
- Dynamo Interface ................................................................................................................... 8
  - Dynamo welcome screen ................................................................................................... 8
  - Files ...................................................................................................................................... 8
  - Recent ................................................................................................................................. 8
  - Backup ............................................................................................................................... 8
  - Ask ....................................................................................................................................... 8
  - Reference ............................................................................................................................ 8
  - Code Resources .................................................................................................................. 8
  - Samples .............................................................................................................................. 8
- Dynamo User Interface .......................................................................................................... 9
  - Menus ................................................................................................................................. 10
  - Toolbars ............................................................................................................................. 10
  - Library ............................................................................................................................... 10
  - Workspace .......................................................................................................................... 11
  - Console ............................................................................................................................... 11
  - Execution Bar ..................................................................................................................... 11
- Breaking Down the Graph ...................................................................................................... 12
  - Library ............................................................................................................................... 12
  - Deconstructing the Node .................................................................................................... 14
    - Ports ............................................................................................................................... 14
  - Most Helpful Nodes ............................................................................................................ 17
  - Watch Nodes ...................................................................................................................... 17
  - Code Block Node ............................................................................................................... 18
Introduction to Dynamo

Dynamo is a ‘visual programming tool’ that works with Civil 3D and other Autodesk products. A ‘visual programming tool’ allows users to create programs or scripts by manipulating program elements graphically rather than specifying them textually. It revolves around the idea of ‘boxes and arrows,’ where boxes or other screen objects are treated as entities, connected by arrows or lines which represent relationships.

DesignScript is at the heart of Dynamo. It is a readable and concise language that offers immediate feedback with small bits and is scalable for large and complex interactions. It was built from scratch to support exploratory design workflows, and its functionality has a one-to-one relationship with the scripting language. It offers opportunities to flow between visual and graphical coding fluidly.

Why would I use this?
- Automate repetitive tasks. Reduce the number of clicks each day!
- Access the data within Civil 3D
- Create many design options faster (Generative Design)
- Improve efficiency and productivity
- Write code in a visual way

How do I install it?
Dynamo is not part of the initial installation of Civil 3D 2020, and it requires a separate download and installation. There are two basic ways to download and install Dynamo; Autodesk Account or the Autodesk Desktop Application. The only requirement for accessing the Dynamo for Civil 3D download is an active subscription to Civil 3D.
Install through Autodesk Account
Installing through the Autodesk Account is recommended if deploying to multiple machines throughout an organization. If you subscribe to various products, use the “Filter” on the top right of the page. This product is only available in 2020, so make sure to check the appropriate version box.

View from Autodesk Account
1. Click “Product Updates” from the menu on the left side of manage.autodesk.com
2. Locate Dynamo for Civil 3D 2020 in the list of available updates.
3. Click the Download button to the far right of the list
4. Once the download completes, launch the .exe to install Dynamo
Install through Autodesk Desktop Application
Installing through the Autodesk Desktop Application is best suited when installing on individual machines. The Desktop App will filter relevant product updates for you based on applications currently installed on the device. One of the significant benefits of the Autodesk Desktop Application is that it will download and install Dynamo for Civil 3D 2020 for you.

View from Autodesk Desktop Application

2. Log-In into the Desktop Application
3. Click on the Civil 3D Icon on the left pane of the window.
4. Search for “Dynamo for Autodesk Civil 3D 2020.”
5. Click “Update”

Note: If prompted, choose YES on the “User Account Control” dialog box.
Where do I find it once installed?
Since Dynamo is not a stand-alone product, you must launch Civil 3D 2020 to access Dynamo for Civil 3D and create scripts.

- Clicking the “Dynamo” command will open the Dynamo application.
- Clicking “Run Script” will run a script (.dyn) file without the need to open the application.

Dynamo Interface

Dynamo welcome screen
When you first launch Dynamo inside of Civil 3D, you will see the welcome screen.

Files
Create New .dyn file, Custom node or open existing .dyn file

Recent
Recently accessed .dyn files, up to 5

Backup
Location of backup .dyn files

Ask
Access the Dynamo website and Discussion forums, a great resource!

Reference
Tutorials and resource materials for learning Dynamo for Civil 3D

Code Resources

Samples
A great resource to view additional samples
Dynamo User Interface
The interface of Dynamo is like other Autodesk product interfaces. The largest area is the workspace, where we create our graph. We use the term ‘graph’ quite frequently in this document, which is a visual term of the script (.dyn) file you are creating.

1. Menus
2. Toolbar
3. Library
4. Workspace
5. Console
6. Execution Bar
Menus
In this area, you will find a few of Dynamo’s basic functionality related to managing files and operations for selection and content editing. You will also find a few tools to help organize your graph, customize some of the appearances of your graph, and set the modeling range.

Toolbars
In this area, you will find a quick access menu related to working with files, including Redo and Undo commands. The most useful part of this area is the camera on the far right. If you are having trouble and need to share your work with someone, use this camera icon to snapshot as a ‘.png’ and share on the Dynamo community.

Library
The Library contains all the Out of the Box (OOTB) nodes included with Dynamo for Civil 3D and any Custom Nodes or Packages that you have loaded. Each node within the library is found within categories and sub-categories. We will talk more about the Library later in this document.

1. Nodes specific to AutoCAD and Civil 3D (we review later in this handout)

2. Dynamo default library. Geometry is a great place to begin exploring as it contains the most substantial quantity of nodes.

3. Add-Ons area is where you can find custom node packages created by others and installed.
Workspace
The Dynamo Workspace is where we create the visual programs and preview any geometry as a result. There are two viewing options on the top right of the interface; the graph and the effects if any geometry created. The graph preview is active by default, using the Navigation buttons or middle mouse button to pan and zoom will move throughout the Graph.

1. Toggles between Graph and 3D Geometry results
2. Zoom and Pan controls.

Tip: You can use your mouse the same as you can in Civil 3D to navigate the workspace. For specific hotkeys, check out the dynamo primer at https://primer.dynamobim.org/02_Hello-Dynamo/2-3_the_workspace.html

Console
The Dynamo Console area will allow you to view and debug your dynamo script. This window is turned off by default. The setting is found through View > Show Console or Ctrl + Shift + Up.

Execution Bar
The Execution Bar gives you options for how and when to run your script. You can choose automatic, manual, or Periodic. It is recommended to set this to “Manual” when you are building your graph. When you feel confident your work, click run, and review any warnings within your program.
Breaking Down the Graph

Library
The Library inside of Dynamo contains a vast number of nodes. Nodes are like commands, and each node performs an operation in Dynamo. As previously mentioned, the top two categories, “AutoCAD” and “Civil 3D” contain nodes specific to AutoCAD and Civil 3D objects. The remaining categories are part of the Dynamo core and include basic operations like numbers, import, export, etc.

Since Dynamo may be very new to you, getting an understanding of what nodes are available can be overwhelming. Use the “Search” area at the top of the library to enter a term like “Surfaces” to view nodes available involving surfaces.

There are many different types of nodes relating to surfaces. Notice the three pieces of information under the name of the node; the Selection (Icon) Civil 3D
“Selection” refers to the sub-category of the main “Civil 3D” category in the library. The icon refers to the type of operation this node performs. There are three types of operations in Dynamo; Create, Action, Query. Each denoted with an icon.

Left-clicking on the “Selection” sub-category will take us back to the expanded library. It will display what other types of objects we can “Select.”

We can also select other Civil 3D Objects like Alignments, CogoPoints, Corridors, and Surfaces. These are the nodes available in Dynamo for Civil 3D at the time of this document. This list will expand with additional options in the future.

Hovering your mouse over the node listing in the Library will provide additional information as to the specific operation of the node.

This node’s operation is selecting all alignments in the drawing. By left-clicking, this listing will place the node in the workspace of Dynamo.
Deconstructing the Node
Nodes are typically made up of five parts.
The name of the node typically follows the category.Name format, and can be modified by double-click on the node. It is strongly encouraged to append the name rather than overwrite, mainly if sharing will occur. Node structure is as follows;

1. Name - Category.Name format
2. Ports (Input) - Input of data to the nodes.
3. Ports (Output) – Output of data from the operation of the node
4. Lacing Icon – this provides a preview of the data the node will output.
5. The thumbtack area which shows a list of the node’s results.

Ports
Dynamo graphs work in a left to the right process. Data is ported in from the left, the node performs an operation, and the result is then ported out to the right. Receiving, or input ports, expect to collect data of a particular type. These data types include the basics of a programming language like INT, DOUBLE, STRING, BOOL as well as object-specific types like POINT, ALIGNMENT, DOCUMENT. If you are unfamiliar with any programming language, there are a few basics that will help when learning Dynamo.

INT – stands for integer, a numeric value in a whole number format.
STRING – a word, sentence or line of text
DOUBLE – a numeric value usually in a decimal point format. The same as “number.”
BOOL – stands for Boolean, a binary variable with two possible values called “True” and “False.”
You can preview the required data type by hovering over the input port on the node.

If you do not connect the appropriate data types to the port, then the transfer of data from one node to the next will result in an error.

The node will change color and inform you of the expected arguments.

Dynamo uses different color schemes to represent the node’s status. Hovering over the name of the node presents additional information and options.
**NODE STATES – IMAGE AND DATA ARE FROM THE DYNAMO PRIMER**

1. **Active** – Nodes with Dark Grey Name background are well-connected and have all of their inputs successfully connected.
2. **Inactive** – Grey Nodes are inactive and need to be connected with Wires to be part of the Program Flow in the active Workspace.
3. **Error State** – Red indicates that the Node is in an Error State
4. **Freeze** – A Transparent node has Freeze turned on, suspending the execution of the node
5. **Selected** – Currently selected Nodes have an Aqua highlight on their border
6. **Warning** – Yellow Nodes are in a Warning state, meaning they may have incorrect data types
7. **Background Preview** – Dark Grey indicates that the geometry preview is turned off.

[Link to Dynamo Primer](https://primer.dynamobim.org/03_Anatomy-of-a-Dynamo-Definition/3-1_dynamo_nodes.html)

Like the basics of a programming language, Dynamo provides many other input port variables for AutoCAD / Civil 3D components like “Documents, blocks, alignments, mesh, lines, surfaces, cogo points, coordinates, etc.” The most important thing to remember is to look at the input of the node to see what data type is needed.
1. Input parameter calls Alignment
2. Output parameter is Alignment
3. Input parameter needs “Double.”
4. Output parameter provides “Number” (same as double)
5. Input parameter needs “Bool.”
6. Output parameter provides “Bool” (true or false to include geometry stations)

Most Helpful Nodes
Two of the most helpful nodes when creating your graph are the ‘watch’ nodes and the ‘code block’ nodes.

Watch Nodes
There are three types of watch nodes available in the Display category of Dynamo; Watch, Watch3D, and Watch Image. These nodes will allow you to see the output information of a node in text, 3d, or image format. If you are curious as to what data or information one node is passing off to the next, adding the “Watch” node will give you insight. The watch node’s only function is to display the information contained within the node operation.

Using the ‘watch’ node output port may confuse others, we recommend that you do not utilize the output port of the ‘watch’ node.
Note: The watch node displays four Alignments in this drawing and the names.

**Code Block Node**

Code blocks are an expeditious and easy way to enter information into Dynamo. You can find the code block node under the “Script > Editor” category in the library, or you can create one by double-clicking on an open area of the workspace.

Because code blocks are a minor view of the programming heart of Dynamo, we can use code blocks and DesignScript syntax for any number of different data types.

“Code block” is a bit intimidating to non-programmers, but can be used with minimal coding. To learn more about DesignScript syntax to use within the code block node, check out the Dynamo Primer ([https://primer.dynamobim.org/07_Code-Block/7-2_Design-Script-syntax.html](https://primer.dynamobim.org/07_Code-Block/7-2_Design-Script-syntax.html))
Code blocks are flexible when it comes to data types, and we can use them in place of traditional nodes. As you can see in this example, using code blocks can elevate efficiency when laying out your graph.

There are several shorthand methods to use within the code blocks that simplify data management. Check out the Dynamo Primer, which has a great explanation of these shorthand methods.
Wires
We have established the node and understand the operation it will perform. Our next step will be to pass information from one node to the next. “Wires” connect the node operations and allow data to be given or transferred to the next operation.

We can arrange nodes however we want on the graph, but keep in mind that nodes include input values on the left and output on the right. Placing nodes in a left to right fashion, and connecting them will help visualize how data is moving through your graph.

To create a wire, left-click on the output port and then left-click on the input of another node. While dragging from the output to the input, you will see a dashed line. Once you click on an input of another node, the line will become solid, making you aware of the connection.

To edit a wire or disrupt the flow of data, left-click on the Input side of the node and drag to another node or left-click in white space to release the dashed line.

When a node is selected, the connecting wires will also display in a light blue color. The color also helps visualize where data is coming from and where it is going.
Dynamo also allows us to customize the appearance of the wires.

To change the appearance of the wires or turn them off completely;

Click View > Connectors > Connector Type >
Managing the Data
As we are laying out our graph, you will be working with a lot of data. Each node represents a list of the data it contains. These lists are a collection of elements or items produced from the operation of the node.

Lists are essential because they allow you to work with multiple items at once, or pick one piece of data to apply a new operation. As you work in Dynamo more frequently, you will find a significant portion of your workflow is list management. To use lists effectively, you need to be aware of the numbering system. In Dynamo, each item in the list has an index and uses a zero-based counting system. Zero-based means the first item in the list starts at “Index 0”.

In this example, we have a list of 4 Alignments selected (List 0-3), and also a Station query every 60’ along each alignment. Our “Watch-Stations” gives us another list (0-3) that corresponds with the Alignment List. “2 List” represents stations every 60 feet along the “Elm St” alignment.

In the Watch-Station List, each List 0-3 contains a sub-list of stations.
Creating Lists
Not only can we work with lists of data captured by the node operation, but we can also use lists to reduce the number of nodes in our graph. There are a vast amount of available list operations to choose from, the more you work in Dynamo, the more versed you will become in the specific operations. We outline a few concepts below, but for more information, refer to the Dynamo Primer.

To create a basic list:
1. Create 4 Number nodes, setting the values to 10, 20, 30, and 40.

2. Library > List > Generate

3. Click on the “List Create” to add the node.
4. Click on the “+” symbol on the List Create node to add three more indexes.

5. Create wires to connect the output of each numbered node to the input of each item on the list create node.

6. Click run in the execution bar, and hover over the bottom right of the node to pin the results.
Creating Lists using Ranges and Sequences

Ranges and sequences can be helpful in many situations by providing a list of numbers for input.

1. List > Generate > Range
2. Select Range node
3. Select Sequence node

For the Range Node, the inputs are start, end, and step. Specify the start and endpoints for a range of numbers or letters, and then specify the space between each item in the list.

Note: The step must be numerical value even when using letters.
The Sequence Node is similar; you specify the start, the amount (or how many you want in the list), and the step. The Sequence Starts at ten and counts every 20, 10 times.

You can also use a code block to create a Range. You must enter the start value, end value, and step value, each separated by two dots.

You can also use a code block to create a Sequence. You must enter the start value, the number of items or amount, and the step value, each separated by two dots. The only difference is that you must place the number sign (#) before the amount value.
Lacing
When working with lists, it is imperative to understand lacing as this is part of how information in a node is processed. Lacing provides the opportunity to match data of two different sized lists. Let’s take our two lists and lace them to know how lacing works;

1. Place a ‘+’ operator node in the workspace
2. Connect the Range List output to the “+” Node Input of X
3. Connect the Sequence List output to the “+” Node Input of Y
4. Execute the script (bottom left click ‘Run”)

5. Right Click on the “+” node and Select Lacing
6. Select “Longest”

When applying a different lacing option, the icon in the bottom right of the node changes. This icon indicates the type of lace used.
Result: The numbers at each Index0 area added together. The remaining numbers in the “Longest” list are then increased by 40.

40 is the value of the bottom list index4, which is not present in the top list. Lacing adds 40 to each list index succeeding index3.

There are many different operations when working with lists. See the Dynamo Primer for more information.

https://primer.dynamobim.org/06_Designing-with-Lists/6_designing-with-lists.html
Organize/Customize the Graph

Graph Strategy
As you develop your Dynamo graph, it can quickly increase in size and complexity. It is vital to create a functioning program as simple as possible. Not only will your graph run more efficiently, but other users will be able to understand the logic later. Reducing complexity, maintaining readability, and ensuring reusability should be considered as you develop your graph. This section discusses a few tools to help organize and customize your graph.

Groups
Grouping nodes are a great way to reduce complexity and help others understand which nodes work together in your graph. Groups allow you to create distinct parts of your program and move large parts of the program at the same time. Changing the color of the group can help differentiate function (Inputs vs. Functions).

To create a group:
1. **Select** the desired nodes, so they are all highlighted. You can hold down the Shift Key + Left Mouse click to select individually or use the window.

2. While highlighted, **Right-Click > Create Group**
Once a group is created, right-clicking provides additional options such as Ungroup, Font Size, and the ability to change the background color.

Selecting the background color will choose the entire group. Holding the left mouse button will allow you to move the grouped nodes together. You can also move the nodes inside the group, and the size will adjust automatically.

Double Clicking on the group will allow you to name the group.
You can also condense your graph using the “Node to Code” feature. This process will allow you to condense code without eliminating the program’s clarity. There are pros and cons to consider when using Node to Code feature;

**Pros:**
- Quickly summarizes code and still editable
- Useful where certain parts will not often change
- Simplify a significant portion of your graph

**Cons:**
- Generic naming makes it less legible
- More difficult for others to understand
- No easy way to return to Node

To translate from “Node to Code”;

1. **Select** the desired nodes, so they are all highlighted. You can hold down the Shift Key + Left Mouse click to select individually or use the window.

2. While highlighted, **Right-Click > Node to Code**
Maintain Readability
Maintaining readability is another essential piece in your graph strategy. Strive for graphic clarity. Sometimes despite your best efforts, relationships, and flow of data may not be readily apparent. A simple note, grouping, or renaming can save you or someone else unnecessary confusion. There are several ways to ensure readability in your graphs.

Aligning nodes as you go is very helpful in keeping things organized and ensuring that your wires flow smoothly. You can either do this manually by moving nodes around or use the “Cleanup Node Layout” feature inside Dynamo.

The “Cleanup Node Layout” feature inside of Dynamo can be used in two ways; Selecting individual nodes or when no nodes are selected. Try the tools yourself to see how well it aligns pieces of your graph.

To use the “Cleanup Node Layout” feature;

1. Select the desired nodes, so they are all highlighted. You can hold down the Shift Key + Left Mouse click to select individually or use the window.

2. While highlighted, Edit > Cleanup Node Layout or Ctrl+L
You can also use the “Align Selection” tools while laying out your graph;

1. **Select** the desired nodes, so they are all highlighted. You can hold down the Shift Key + Left Mouse click to select individually or use the window.

2. While highlighted, **Right-Click > Align Selection**

We can also rename nodes to help with organization and clarity of functionality within the graph. **Be very careful of renaming nodes that are not strictly inputs.**

To rename a node;

1. **Double-click** the node

2. **Type** the new name
Lastly, we can maintain readability by adding or explaining parts of our graph with notes. Sometimes the graph requires an explanation that nodes cannot express. You should also add notes when a graph is extensive and sophisticated and cannot be understood immediately.

To use the “Create Note” feature;

1. **Edit > Create Note** or **Ctrl+W**

Using the Dynamo tools to ensure coherent graph structure and reduce complexity makes it easier for others to modify inputs and utilize pieces of your graph in another graph.
Tips and Tricks

Geometry Settings

There may be times in developing your graph that you experience a warning relating to allowable modeling ranges. This warning refers to the results of the node operation being outside the modeling range currently established within the Dynamo environment. While your script will still run and output the desired results, the warning will be present until you adjust this setting.

Navigate to “Settings > Geometry Scaling.”

By default, the working range is “Medium” which allows maximum values of 10,000 units.
Since the results of our node operations are above 1,000,000 (1 Million) units, we need to increase this size. Large is up to 1 Million, but Extra Large allows up to 100 Million.

Clicking on “Extra Large” and “Apply Changes” clears the warning. It's important to note that this setting will re-adjust with each new session and may need to be modified again in future graphs.

Run Dynamo Command
Earlier in this document, we reviewed how to access the Dynamo interface. There is a second command available to the right called “Run Script.” This command allows you to run a .dyn file (a Dynamo script format) without the need to open the graph.

Missing Nodes
If you ever notice missing nodes upon reopening a completed graph, ensure the latest service pack for Civil 3D is applied. At the time of this presentation, Civil 3D 2020.1.1 is the newest version.
Advanced Topics

Custom Nodes

Creating Custom Nodes

Dynamo contains an expansive library of nodes to handle a wide range of programming tasks. While it continues to be updated regularly with new nodes, sometimes you need something custom. There are several methods for creating custom nodes; from scratch, an existing graph, or using C#.

This section covers how to create a custom node from an existing graph. If you are interested in learning how to create a custom node from scratch, please visit the Dynamo Primer for more details.

You may find a time when you create a function within Dynamo that you want to use numerous times in the future. Rather than recreating multiple nodes again and again, or copying from one graph to another, you can select them and package them into a ‘custom node.’

To create a custom node from an existing graph;

1. **Select** the desired nodes, so they are all highlighted. You can hold down the Shift Key + Left Mouse click to select individually or use the window.

2. While highlighted, **Right-Click > Create Custom Node**
Custom nodes appear in the Add-Ons section of the library (very bottom). The name of your custom node cannot contain any special characters, including spaces.

3. **Type** the name of your custom node and description

4. **Select** or **Type** which Add-ons category you place your custom node.

5. **Select** OK

Once you’ve created your custom node from the collection of nodes on your graph, you will see another Dynamo Window at the top of your screen.

Dynamo indicates when you are in a custom node by changing the background color of the workspace to a yellow color.

To ensure your node is available the next time you open Dynamo, or to share with others in or out of your organization, you should publish.
Publishing

You can publish a custom node locally or online. In this case, we’ve created a custom node based on an existing graph. Publishing will allow this collection of nodes to be used repeatedly without having to recreate or copy in each new graph.

By publishing a node locally, the node will be available the next time you open a new session of Dynamo. If the custom node is not published, you must import the custom node each time into a new graph using File > Import Library. Sharing graphs using unpublish custom nodes also requires the custom node to be available in their library.

To publish a node locally:

1. Right-click on the canvas
2. Select “Publish this custom node.”
Fill in the dialogue box and click Publish Locally.

Choose a folder to contain all the custom nodes that you plan on publishing locally. You can also modify this folder location under Settings > Manage Node and Package Paths.

Publishing a custom node online creates a package.
Packages

Like most programming tools, Dynamo thrives on community involvement and collaboration. The scripts we create are our vehicles to success, with custom nodes as their wheels. By sharing our work, everyone can explore the limits of their automation imagination quicker. Sharing our custom creations with our colleagues will fuel progress for the entire industry.

Dynamo utilizes Packages as the way to share custom nodes with others in your organization, the AEC industry, or the Dynamo community. By using packages, you can publish your custom nodes for others to use, or download custom nodes written by others to utilize in your scripts.

**Downloading a Package**

You can search the Dynamo community for custom nodes or packages created by others and use them in your graphs.

To search for a package;

1. Packages > Search for a Package
2. Enter a term in the search bar at the top
3. Within the results section of the search, click to expand information about a specific package
4. Install the package

You can also visit the package website or repository to find other information regarding the package.

Once the package installs, it appears at the bottom of the Dynamo Library.
Managing Packages

To uninstall or see what packages installed;

1. Packages > Manage Packages

2. The ellipsis on the right-hand side allows for further options, including uninstall.
Conclusion

By integrating Dynamo for Civil 3D workflow concepts into the execution of a project, data entry and repetitive work can be streamlined to improve efficiency and productivity through various phases of the project. We are not only finding ways to improve efficiency but the ability to extend design capabilities via a graphical algorithm editor. Proper graph generation, automation, and data management will allow project teams to isolate tasks, facilitate collaboration, and enhance communication to optimize project delivery.

Dynamo is an open-source tool, which allows the community of users to contribute to its continuous improvement. The best way to learn more about Dynamo for Civil 3D is to start researching, testing, and communicating with fellow professionals in the Dynamo Community! If we as a community continue to enhance automation and as collaboration efforts increase, the possibilities of design become limitless.

Additional Info and Resources

Link for Dynamo Forum (Make sure to filter to the Civil 3D category on the right)
https://forum.dynamobim.com/
https://forum.dynamobim.com/c/civil3d

The Dynamo Primer – Help documents
https://primer.dynamobim.org/

Keep up to date with the latest in Dynamo
https://dynamobim.org/learn/